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SUMMARY: 29 

This protocol describes a method for morphometric analysis of neuromuscular junctions by 30 

combined confocal and STED microscopy that is used to quantify pathological changes in 31 

mouse models of SMA and ColQ-related CMS.  32 

 33 

ABSTRACT: 34 

Neuromuscular junctions (NMJs) are highly specialized synapses between lower motor 35 

neurons and skeletal muscle fibers that play an essential role in the transmission of molecules 36 

from the nervous system to voluntary muscles, leading to contraction. They are affected in 37 

many human diseases, including inherited neuromuscular disorders such as Duchenne 38 

muscular dystrophy (DMD), congenital myasthenic syndromes (CMS), spinal muscular atrophy 39 

(SMA), and amyotrophic lateral sclerosis (ALS). Therefore, monitoring the morphology of 40 

neuromuscular junctions and their alterations in disease mouse models represents a valuable 41 

tool for pathological studies and preclinical assessment of therapeutic approaches. Here, 42 

methods for labeling and analyzing the three-dimensional (3D) morphology of the pre- and 43 

postsynaptic parts of motor endplates from murine teased muscle fibers are described. The 44 

procedures to prepare samples and measure NMJ volume, area, tortuosity and axon terminal 45 

morphology/occupancy by confocal imaging, and the distance between postsynaptic 46 

junctional folds and acetylcholine receptor (AChR) stripe width by super-resolution stimulated 47 
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emission depletion (STED) microscopy are detailed. Alterations in these NMJ parameters are 48 

illustrated in mutant mice affected by SMA and CMS. 49 

 50 

INTRODUCTION: 51 

The neuromuscular junction (NMJ) is a complex structure composed of a motor axon terminal, 52 

a perisynaptic Schwann cell, and a skeletal myofiber portion involved in the transmission of 53 

chemical information and coupling of lower motor neuron activity to muscle contraction. In 54 

mammals, the morphology of the neuromuscular junction changes during development, 55 

adopting a typical pretzel-like shape after maturation, with differences in shape and 56 

complexity between species, and shows some degree of plasticity in response to physiological 57 

processes such as exercise or aging1–4. The postsynaptic motor endplate forms membrane 58 

invaginations named junctional folds, where the upper part containing acetylcholine receptors 59 

(AChR) is in close contact with the presynaptic terminal axon branch5. 60 

 61 

Morphological and functional changes in neuromuscular junctions contribute to the 62 

pathophysiology of several neurodegenerative disorders such as spinal muscular atrophy 63 

(SMA) and amyotrophic lateral sclerosis (ALS), myopathies like Duchenne muscular dystrophy 64 

(DMD), congenital myasthenic syndromes (CMS), myasthenia gravis (MG) and centronuclear 65 

myopathies (CNM), and aging-associated sarcopenia3,6–14. In these diseases, NMJ structural 66 

alterations such as endplate fragmentation, reduced postsynaptic junctional fold size and/or 67 

denervation are observed. The pathology of NMJs can be a primary or early event during 68 

disease progression or appear more lately as a secondary event contributing to the clinical 69 

manifestations. In any case, monitoring the morphology of NMJs in animal models of these 70 

diseases represents a valuable parameter to study pathological changes and assess the 71 

efficacy of potential treatments. 72 

 73 

The morphology of neuromuscular junctions is usually analyzed by techniques using confocal 74 

microscopy2,13–15 or electron microscopy5,16, with their inherent limitations such as resolution 75 

or technical difficulties, respectively. More recently, super-resolution microscopy was also 76 

used to visualize particular regions of the NMJ, such as presynaptic active zones or AChR 77 

distribution on the postsynaptic membrane16–18, as an alternative or complementary 78 

approach to ultrastructural analysis by electron microscopy. 79 

 80 

This protocol aims to provide a detailed and reproducible method to assess NMJ 81 

morphological parameters by combining fluorescence confocal and stimulated emission 82 

depletion (STED) microscopy. Important features of the presynaptic and postsynaptic 83 

endplates, such as volume, area, relative tortuosity, AChR stripe width, and axon terminal 84 

distribution in innervated teased muscle fibers of mice gastrocnemius and tibialis anterior 85 

were quantified in the context of normal and diseased conditions. In particular, NMJ defects 86 

were exemplified in the Smn2B/- mouse model of spinal muscular atrophy (SMA), a 87 

neuromuscular disease with motor neuron degeneration caused by mutations in the SMN1 88 

gene11,19, and in a collagen-like tail subunit of asymmetric acetylcholinesterase knockout 89 

(ColQDex2/Dex2 or ColQ-KO) mice, as a model of the congenital myasthenic syndrome (CMS)20–90 
22.  91 

 92 

PROTOCOL: 93 

 94 



Care and manipulation of mice were performed according to national and European legislation 95 

on animal experimentation and approved by the institutional ethical committee. Males and 96 

females of Smn2B/- (C57Bl/6J background) and ColQDex2/Dex2 (B6D2F1/J background) mice at 3- 97 

and 6-weeks of age, respectively, were used in the study.   98 

 99 

1. Euthanasia of mice and dissection of muscles: tibialis anterior and gastrocnemius  100 

 101 

1.1. Proceed to mouse anesthesia by intraperitoneal injection of a ketamine (87.5 102 

mg/kg)/xylazine (12.5 mg/kg) mixed solution (0.1 mL/20 g of body weight) prior to euthanasia 103 

by cervical dislocation.  104 

 105 

NOTE: Since SMA and ColQ-CMS affect individuals independently of their sex, male and female 106 

mice were used in the present protocol. 107 

 108 

1.2. Remove hindlimbs hair using a small electric shaver and rinse the legs with 70% 109 

ethanol.  110 

 111 

NOTE: The dissection procedure will differ for each muscle. For dissection of tibialis anterior 112 

(TA), follow steps 1.2.1–1.2.3, and for gastrocnemius (GA) (medial and lateral parts), follow 113 

steps 1.2.4–1.2.6. 114 

 115 

1.2.1. Place the mouse in the supine position. 116 

 117 

1.2.2. Make a skin incision of 5 mm with sharp-blunt scissors along the antero-external part 118 

of the distal hindlimb, parallel to the tibia, to expose the muscle. Use extra-thin scissors to 119 

remove the fascia.  120 

 121 

1.2.3. Cut the distal tendon first (close to the paw) and then the proximal tendon (close to 122 

the knee) using extra-thin scissors and a curved thin forceps. Handle the muscle carefully to 123 

avoid damage to myofibers and nerves.  124 

 125 

NOTE: The proximal tendon must be sectioned as close as possible to the bone to harvest the 126 

entire muscle.  127 

 128 

1.2.4. Place the mouse in the prone position, use sharp-blunt scissors to make a skin incision 129 

from the upper part of the distal hindlimb posterior compartment down to the paw, and 130 

remove the skin.  131 

 132 

1.2.5. Grasp the Achilles tendon with medium serrated forceps, cut it with an extra-thin 133 

scissor and gently separate the GA from the surrounding tissue back to its proximal insertion.  134 

 135 

1.2.6. On the proximal side, insert the medium serrated forceps into the pocket formed 136 

between the biceps femoris (BF) and the GA. Separate the two muscles to cut the GA tendon 137 

as close as possible to the bone insertion with an extra-thin scissor. 138 

 139 

NOTE: Handle the muscle gently to prevent tissue damage and crushing or stretching it during 140 

dissection. 141 



 142 

1.3. For tissue fixation, place each muscle into a 2 mL microcentrifuge tube containing 1 mL 143 

of 4% w/v paraformaldehyde (PFA) solution diluted in phosphate buffer saline (PBS without 144 

Ca2+Mg2+) and keep at 4 °C for 18–24 h. 145 

 146 

CAUTION: Paraformaldehyde and formaldehyde are toxic and must be handled in a chemical 147 

fume hood with adequate protective equipment.    148 

 149 

1.4. Next day, wash the fixed muscles 3x for 5 min with PBS in 12-well plates by shaking 150 

gently at room temperature (RT) inside a chemical fume hood.   151 

 152 

NOTE: The protocol can be stopped at this step and continued within a month. In this case, 153 

add PBS supplemented with 0.01% sodium azide to store samples at 4 °C.  154 

 155 

1.5. Tease each muscle in small fiber bundles of about 1 mm wide using two fine serrated 156 

forceps.  157 

 158 

NOTE: It is crucial to manipulate muscles very gently with the forceps, without excessive force, 159 

to prevent tissue damage during teasing. 160 

 161 

1.5.1. Dissociate the TA muscle into 3 or 4 bundles depending on its size.  162 

 163 

1.5.2. For GA, separate the medial and lateral parts of the muscle and then dissociate each 164 

part into 4–5 bundles depending on their size. 165 

 166 

2. Immunostaining 167 

 168 

2.1.  Proceed with muscle fiber permeabilization: Transfer muscle bundles into 24-well 169 

plates containing 1% (v/v) Triton X-100 in PBS and keep them under gentle agitation (50 rpm) 170 

for 1 h at RT or 5 h at 4 °C.  171 

 172 

NOTE: Split the muscle bundles between two plates to proceed with separate 173 

immunostainings and to minimize the risk of antibody confusion. Do not split them into more 174 

than two wells (1 well/plate); otherwise, the number (N) of NMJs that are representative of 175 

their general status in the analyzed muscle may be insufficient.  176 

 177 

2.2. Wash the samples 3x for 5 min with PBS at RT and incubate them with a blocking 178 

solution composed of 4% bovine serum albumin (BSA) in PBS/Triton X-100 1% for 4 h at 4 °C, 179 

under gentle agitation (50 rpm).  180 

 181 

NOTE: Do not use an aspiration pump during the washing steps, but rather aspirate the 182 

solution manually with a 200 µL pipette and small-sized tips (the reference is indicated in the 183 

Table of Materials). 184 

 185 

2.3. Incubate the samples overnight (O/N) at 4 °C under gentle agitation (50 rpm) with the 186 

blocking solution indicated in step 2.2 containing primary monoclonal antibodies against 187 



either neurofilament M (NF-M, 2H3, dilution 1/200) or synaptic vesicle glycoprotein 2 (SV2, 188 

dilution 1/200) to label presynaptic axon terminals or active zones, respectively.  189 

 190 

2.4. Next day, wash the muscle bundles 3x for 5 min in PBS under agitation (50 rpm). 191 

 192 

2.4.1. For confocal imaging: Incubate the muscle bundles with secondary anti-mouse 193 

antibodies conjugated with a red-emitting fluorophore (F594) (dilution 1/500) and α-194 

bungarotoxin conjugated with a green-emitting fluorophore (α-BTX-F488) (dilution 1/1000) in 195 

PBS for 2 h at RT under agitation (50 rpm).  196 

 197 

2.4.2. For STED imaging: Incubate the muscle bundles with secondary anti-mouse antibodies 198 

conjugated with a green-emitting fluorophore (F488) (dilution 1/500) and α-bungarotoxin 199 

conjugated with a far-red-emitting fluorophore characterized by high photostability (α-BTX-200 

F633) (dilution 1/1000) in PBS for 2 h at RT under agitation (50 rpm). 201 

 202 

NOTE: Do not expose the samples to light during incubation to avoid photobleaching.  203 

 204 

2.5. Wash the labeled muscle bundles 3x for 5 min with PBS under agitation (50 rpm) and 205 

place them on a slide with a mounting medium.  206 

 207 

NOTE: Place a maximum of 4 to 5 muscle bundles per slide to allow sealing. 208 

 209 

2.6. Add a grade #1.5 (or #1.5H) glass coverslip (0.17 mm thickness) on the top, and place 210 

cylindrical magnets on both sides of the slide to apply pressure and flatten the muscles.   211 

 212 

2.7. Keep the slides protected from light O/N at 4°C. Seal the slides permanently with nail 213 

polish. 214 

 215 

3. Image acquisition  216 

 217 

3.1. Acquisitions by a confocal microscope 218 

 219 

NOTE: Images were collected with an inverted laser-scanning confocal microscope using a 63x 220 

magnitude oil immersion objective (HCX Plan Apo CS, 1.4 numerical aperture (NA)).  221 

 222 

3.1.1. For blinded analysis, let a person not involved in the analysis code each slide with a 223 

given number. Let the person remain blinded to the experimental groups until the 224 

quantification of NMJ parameters is complete for all samples. 225 

 226 

3.1.2. Launch the microscope software in Configuration Mode > machine.xlhw 227 

(Supplemental Figure 1). 228 

 229 

3.1.3. Place the slide on the microscope stage and find the observation plane within the 230 

sample by looking under DAPI wide-field fluorescence illumination with the DAPI filter set. 231 

 232 

3.1.4. Click on Open Project > New Projects and create a folder to store image acquisitions 233 

(Supplemental Figure 1).  234 



 235 

NOTE: Create a new project for each NMJ to limit folder size and prevent computer memory 236 

issues.  237 

 238 

3.1.5. To manage acquisition parameters, click on the Acquisition tab window and set the 239 

confocal pinhole to 1.0 Airy unit and laser power to optimize the gain and offset levels for the 240 

green/F488 (α-BTX) fluorescence using a 488 nm laser at the endplate that has to be imaged 241 

(Live mode ON).  242 

 243 

3.1.6. Next, optimize the red/F594 (NF-M or SV2) fluorescence acquisition using a laser 244 

adapted to F594 observation. In this study, a 552 nm laser was used (Live mode ON).  Set the 245 

spectrum of dye emission with the following ranges for each laser: laser 405 (DAPI) from 414 246 

to 483 nm, laser 488 (F488-α-BTX) from 506–531 nm, and laser 552 (NF-M/SV2) from 622–650 247 

nm. 248 

 249 

3.1.7. Collect image stacks of neuromuscular junctions in each experimental group with the 250 

same settings: image size 1024 x 1024 pixels (73.7 x 73.7 µm) at 400 Hz sampling rate, 251 

Bidirectional X ON, Zoom factor 2.5, Z-step size 0.5 µm in Z-Wide mode.  252 

 253 

NOTE: For each NMJ, the number of slices is set to acquire the whole junction. The acquisition 254 

settings described above fulfill the Nyquist-Shanon sampling theorem. However, the user can 255 

click on the Optimize Format button, present on all recent confocal operating software, to 256 

ensure pixel size and Z-step meet the ideal Nyquist sampling rate. This action will avoid over 257 

or under-sampled images, which will cause a loss of accuracy in volume measurements. 258 

 259 

3.1.8. Save the images with a file name that includes the code name of the slide, the staining 260 

type, and the endplate number.  261 

 262 

NOTE: Collect sequentially (not simultaneously) the scans using the 488 nm and 552 nm lasers 263 

(F488 and F594) to avoid crosstalk of the F488 fluorescence into the F594 channel and vice 264 

versa (bleed-through). NB:  the beam path can be configured with the Dye Assistant in the 265 

microscope software.  266 

 267 

3.1.9. Change to the next coded slide and repeat steps 3.1.3–3.1.8 for each NMJ. 268 

 269 

3.1.10. At the end of the session, click on Open in 3D Viewer and choose an NMJ 270 

representative of an experimental group to visualize the 3D labeling.  271 

 272 

NOTE: This view mode will help to verify that the acquisition parameters were correct. 273 

 274 

3.1.11. Close the microscope software, clean the objectives with lens tissues, and then turn 275 

off the system. 276 

 277 

3.2. Acquisitions by STED microscopy 278 

 279 

NOTE: Images were collected with an inverted laser-scanning confocal microscope equipped 280 

with Gated STED at 775 nm using a 100x oil immersion objective (HC PL APO CS2 1.4 NA).  281 



 282 

3.2.1. For blinded analysis, let a person not involved in the analysis code each slide with a 283 

given number. Let the person remain blinded to the experimental groups until the 284 

quantification of NMJ parameters is complete for all samples. 285 

 286 

3.2.2. Launch the microscope software in Configuration Mode > machine.xlhw and STED ON 287 

(Supplemental Figure 2). 288 

 289 

3.2.3. Click on Open project > New Projects to create a folder to store image acquisitions. 290 

 291 

 NOTE: Generate a new folder for each slide to limit folder size and prevent computer memory 292 

issues.  293 

 294 

3.2.4. Place the slide on the microscope stage and view it under wide-field fluorescence 295 

illumination using the 488 nm laser to find the observation plane within the sample.  296 

 297 

3.2.5. Search for a NMJ labeled with neurofilament M (NF-M) or SV2 stainings using the 488 298 

nm laser with a spectral detection from 506–531 nm.  299 

 300 

3.2.6. When a NMJ has been identified, click on Activate STED and start acquiring images in 301 

a region that contains several junctional folds (Supplemental Figure 3) using the 635 nm laser 302 

with a spectral detection from 640–750 nm.  303 

 304 

NOTE: Be careful to the saturation look-up table during image acquisition and click the Quick 305 

LUT button to avoid overexposure (grey values >255; for 8 bit).  306 

 307 

3.2.7. Collect the images of each experimental group with the same settings: image size 2048 308 

x 2048 pixels (38.75 x 38.75 µm) at a 400 Hz sampling rate.  309 

 310 

NOTE: The depletion laser (STED) power is set to 65%. 311 

 312 

3.2.8. Save the images with a file name that includes the code of the slide.  313 

 314 

NOTE: It is possible to click on Optimized XY Format: Set Format to to obtain the best 315 

acquisition setting with STED imaging.  316 

 317 

3.2.9. Change to the next coded slide and repeat steps 3.2.3–3.2.8. Repeat this procedure for 318 

all slides. 319 

 320 

3.2.10. At the end of the STED microscopy session, transfer the image files to another 321 

computer and save the original files (.lif) in an external drive or server. 322 

 323 

3.2.11. Turn off the microscope software, clean the objectives with lens tissues, and then turn 324 

off the system. 325 

 326 

4. Image analysis- confocal microscopy  327 

 328 



NOTE: All images were processed with computers using Microsoft Windows 10 professional 329 

operating system. 330 

 331 

4.1. Launch ImageJ and custom macro to calculate postsynaptic NMJ endplate volume, 332 

Maximum Intensity Projection (MIP) area, and relative tortuosity.  333 

 334 

4.1.1. Process NMJ image stacks using NIH ImageJ freeware23, the iGeodesic plugin and the 335 

custom macro to obtain NMJ parameter measurements. Launch ImageJ software.  336 

 337 

NOTE: The latest version of ImageJ is freely available and can be downloaded24. In order to 338 

open proprietary file formats, Bio-Formats Package25 plugin has to be downloaded26 . This step 339 

is not necessary in case the operator uses Fiji because the plugin is already installed in the 340 

software. The iGeodesic plugin27 to compute tortuosity is also available online28; verify the 341 

availability of this plugin in the ImageJ/Fiji version that will be used. The custom-made Macros 342 

are also available online29. 343 

 344 

4.1.2. Drag and drop the Macro_NMJ_VOL_Marinelloetal.ijm (custom made, 345 

Supplementary Coding File 1) to the ImageJ window; the macro will be open in a second 346 

window. In this new window, click on Macros > Run Macro.  347 

 348 

NOTE: The macro can process both proprietary and TIFF files. Files must fulfill the following 349 

criteria: for proprietary file formats, save only one junction (i.e., the stack of images) per file, 350 

ordered in a folder; for TIFF images, files must be saved in a folder containing subfolders, each 351 

named JunctionX (X corresponds to a NMJ number) with the image stacks of a given junction 352 

(RGB TIFF) (Supplemental Figure 4).  353 

 354 

4.1.3. Select the native folder containing the Junction subfolders that have to be analyzed 355 

and click on Select. 356 

 357 

4.1.4. In the new pop-up menu called Saving Folder, select the storage folder and click on 358 

Select. 359 

 360 

4.1.5. In the new pop-up menu called Image Type, select the format of the Z-stack 361 

acquisitions.  362 

 363 

4.1.6. Select the RGB channel corresponding to the staining of interest and indicate XY pixel 364 

size and Z-step (z). The macro will automatically perform the analysis.  365 

 366 

NOTE: In case proprietary file formats are selected, the macro directly reads pixel size and Z-367 

step (z). However, the user still has to indicate the channel of interest (C1, C2, or C3). The 368 

macro will provide a DataSheet (.csv) for each junction parameter (endplate volume, MIP area, 369 

and tortuosity) in the saving folder.  The macro also generates three .TIF files, which 370 

correspond to the perimeter of α-BTX staining Drawing_MaxprojX.tif, DrawingJunctionX.tif, 371 

and MIP MaxprojX.tif. These TIFF files are generated to verify the quality of the acquisitions 372 

and to ensure that image processing has been performed correctly. 373 

 374 



Postsynaptic NMJ volume (V): The macro will separate images from a single NMJ and keep the 375 

α-bungarotoxin F488 channel corresponding to the postsynaptic endplate. The stack is 376 

segmented using Otsu threshold30 on the intermediate slice of the stack. The resulting binary 377 

image is 1-pixel dilated, and the Analyze Particles feature is used to measure the endplate 378 

area of each detected object. To obtain the postsynaptic NMJ volume, the macro sums all 379 

measured endplate areas of the stack and multiplies it by Z-step value (z) in µm. 380 

 381 

𝑉 = 𝒛 × ∑ 𝐸𝑛𝑑𝑝𝑙𝑎𝑡𝑒 𝐴𝑟𝑒𝑎

𝑵𝒔𝒍𝒊𝒄𝒆

        382 

 383 

 384 

Maximum intensity projection (MIP) endplate area: After the stack is thresholded, the 385 

maximum intensity projection (MIP) is obtained using the Z-project ImageJ feature. The 386 

Analyze particles feature is then used to quantify the MIP endplate area. 387 

 388 

NMJ MIP tortuosity (T): The NMJ tortuosity, which reflects the degree of complexity of the 389 

postsynaptic motor endplate including folds and perforations31, is calculated based on each 390 

MIP using the following formula, where dObj(AB) is the distance between A and B along the 391 

perimeter of the object, and dEuc(AB) is the Euclidian distance between A and B (straight line).  392 

 393 

𝑇 = ∑ ∑
𝑑𝑂𝑏𝑗(𝐴𝐵) 

𝑑𝐸𝑢𝑐(𝐴𝐵)
𝐵 ∈ 𝑂𝑏𝑗𝑒𝑐𝑡𝐴 ∈  𝑂𝑏𝑗𝑒𝑐𝑡

  394 

 395 

4.1.7. Set the highest tortuosity value in the wild-type group of each experimental condition 396 

to 100%, and normalize all the other values of the experimental condition to this value in order 397 

to obtain the relative NMJ tortuosity. 398 

 399 

4.2. Launch ImageJ and custom macro to quantify presynaptic neurofilament accumulation 400 

and synaptic vesicle glycoprotein 2 staining. 401 

 402 

NOTE: Neurofilament accumulation (here, NF-M) and/or altered distribution of synaptic 403 

vesicles (here, SV2) are markers of abnormal axonal transport and/or impaired vesicle 404 

trafficking and were previously observed in NMJs of various SMA mouse models32–34. 405 

 406 

4.2.1. Drag and drop the Macro_NMJ_ACCU_Martinelloetal.ijm to the ImageJ window; the 407 

macro will open in a second window. In this new window, click on Macros > Run Macro.  408 

 409 

NOTE: The macro can process both proprietary file formats and TIFF files. Files must fulfill the 410 

criteria indicated in the NOTE below step 4.1.2. 411 

 412 

4.2.2. Select the native folder containing the Junction subfolders that have to be analyzed 413 

and click on Select. 414 

 415 

4.2.3. In the new pop-up menu called Saving Folder, select the storage folder and click on 416 

Select.   417 

 418 



4.2.4. In the new pop-up menu called Image Type, select the format of the Z-stack 419 

acquisitions.  420 

 421 

4.2.5. In the Staining Infos pop-up, indicate the presynaptic and postsynaptic label and color 422 

and click on OK. For instance, Presynaptic label: SV2, Presynaptic color: R, Postsynaptic label: 423 

BTX, Postsynaptic color: G.  424 

 425 

NOTE: For proprietary file formats, labels and corresponding channels (C1, C2, or C3) have to 426 

be indicated.  427 

 428 

4.2.6. In the Pixel Size pop-up, indicate XY pixel size 0.072 µm and Z step 0.5 µm (z) and click 429 

on OK.  The macro will automatically perform the analysis.  430 

 431 

NOTE: This parameter corresponds to the image size 1024 x 1024 pixels (73.7 x 73.7 µm) 432 

selected before confocal microscope acquisitions, and it is correlated to the objective and 433 

zoom settings. If the proprietary file formats are selected, the macro directly reads pixel size 434 

and Z-step (z). The macro will store, in the saving folder, a DataSheet (.csv) of presynaptic and 435 

postsynaptic volumes, a multipage TIFF image of the current detection for each (pre- and 436 

postsynaptic) labeling. As indicated above, these TIFF files are generated to check the quality 437 

of the acquisitions and to ensure that image processing has been performed correctly.  438 

 439 

The macro calculates the volume of axonal neurofilament M staining (NF volume) from the 440 

NF-M-F594 channel that colocalizes with α-bungarotoxin-F488 labeling and the volume of 441 

NMJ synaptic vesicle glycoprotein 2 staining (SV2 volume) from the SV2-F594 channel that 442 

colocalizes with α-BTX-F488 labeling. The NF-M accumulation is quantified by calculating the 443 

ratio between NF volume and postsynaptic endplate (α-BTX) volume and NMJ axon terminal 444 

occupancy by the ratio of SV2 and α-BTX volumes, as shown below. 445 

 446 

𝑁𝐹 𝑎𝑐𝑐𝑢𝑚𝑢𝑙𝑎𝑡𝑖𝑜𝑛 =  
𝑁𝐹 𝑣𝑜𝑙𝑢𝑚𝑒

α-𝐵𝑇𝑋 𝑣𝑜𝑙𝑢𝑚𝑒
 × 100 447 

 448 

𝑁𝑀𝐽 𝑜𝑐𝑐𝑢𝑝𝑎𝑛𝑐𝑦 =  
𝑆𝑉2 𝑣𝑜𝑙𝑢𝑚𝑒

α-𝐵𝑇𝑋 𝑣𝑜𝑙𝑢𝑚𝑒
 × 100 449 

 450 

 451 

5. Image analysis- STED microscopy 452 

 453 

NOTE: Image processing was performed with the offline software of the STED microscope 454 

manufacturer.  455 

 456 

5.1. Launch the microscope software. 457 

 458 

5.2. Open the project by clicking on the Open Project button. Select the project file (.lif) 459 

and open it. The images are displayed on the screen along with their names. 460 

 461 

5.3. In the Process window: Click on Noise Reduction > Median. At the bottom of the 462 

middle window, set Radius to 5.00 and Iteration to 1.00, and untick 3D Filtering.  463 



 464 

5.4. Then select the Open Projects tab on the top left of the window and choose an image. 465 

 466 

5.5. Click on Apply to validate parameters. A new image called “nameofimage_median001” 467 

is created.  468 

 469 

NOTE: It is possible to click on Preview prior to Apply to monitor the effect of the median 470 

filter, which will enhance the image contrast and smooth the line profiles used for 471 

quantification. 472 

 473 

5.6. Apply the filter to all images as indicated in steps 5.4–5.5. 474 

 475 

5.7. In the Open Projects tabs, click on the floppy drive icon to save all the projects, 476 

including the newly created filtered images. 477 

 478 

NOTE: The next step will be done using the filtered image named “nameofimage_median001”. 479 

 480 

5.8. Calculate the distance between AChR stripes 481 

 482 

NOTE: Changes in the morphology of postjunctional folds are often observed in 483 

neuromuscular disorders as a sign of NMJ pathology (immaturity or degeneration). The 484 

distance (d) between AChR stripes, which are detected by α-bungarotoxin staining, is 485 

calculated by generating intensity profiles and quantifying the distance between each 486 

maximum intensity peak by drawing a line profile (Supplemental Figure 5). 487 

 488 

5.8.1. Using the microscope software, select the Quantify menu on the top of the central 489 

window.  490 

 491 

5.8.2. Click on the Tools tab in the top left. Select Intensity in the top left panel and click on 492 

the Line profile icon. Set Oversampling to 1, and tick Sort Channels.  493 

 494 

5.8.3. Click on the Open Projects tabs and select the filtered image to be analyzed.  495 

 496 

NOTE: It is possible to zoom in on the image by scrolling with the computer mouse. The 497 

dynamic range of the image can be modified using the bar on the left side next to the displayed 498 

image, which facilitates the visualization of the stripes. 499 

  500 

5.8.4. Then, click on the Draw Line icon in the top menu of the right window and trace a line 501 

crossing perpendicularly several stripes/junctional folds.  502 

 503 

NOTE: The intensity profile is displayed in the central window.  504 

 505 

5.8.5. Click on the top of the first peak and move the mouse pointer while keeping the left 506 

mouse button pressed until the next maximum peak is reached.  507 

 508 

NOTE: The information is shown in the intensity profile, while the distance between the two 509 

peaks is displayed under the chart with “dx” denomination.  510 



 511 

5.8.6. Click right on the mouse while being in the image of the right window and select Save 512 

ROIs. Open the saved ROIs (Regions of Interest) by clicking on Load ROIs.  513 

 514 

5.8.7. Click on the arrow icon in the top left of the right window, click on the ROI and delete 515 

it by clicking on the bin icon.  516 

 517 

5.8.8. Repeat this operation as many times as needed from different intensity profiles to 518 

obtain the predicted number of AChR stripe distances that will represent the global value 519 

correctly in the analyzed muscle.  520 

 521 

NOTE: The optimal N value can be calculated in advance based on the estimated difference 522 

between groups, α risk, power, and one- or two-tailed test. In the current experimental design, 523 

a one-tailed Mann-Whitney test (α risk = 10%; power = 80%) was applied, and the N value was 524 

estimated to be at least five AChR stripe distances per NMJ in order to compare the two groups 525 

of animals.  526 

 527 

5.9. AChR stripe width 528 

 529 

NOTE: The stripe width (w) corresponds to the full-width half-maximum (FWHM) of the 530 

intensity profile, which is the distance between the points where the α-BTX signal 531 

fluorescence value is half of its maximum intensity (Supplemental Figure 5). 532 

 533 

5.9.1. Using the microscope software, select the Quantify menu in the central window.  534 

 535 

5.9.2. Click on the Tools tab on the top left side. Select Intensity in the top left panel and click 536 

on the Determine FWHM icon. Tick Sort Channels.  537 

 538 

NOTE: To optimize the peak detection by the software, Set Threshold and Width were set to 539 

50 and 3, respectively. Adapt these values for each experiment and ask for advice from an 540 

experienced imaging scientist.  541 

 542 

5.9.3. Click on the Open projects tabs and select the filtered image to be analyzed.   543 

 544 

NOTE: It is possible to zoom in on the displayed image in the right window by scrolling with 545 

the computer mouse.  As indicated above (NOTE following step 5.8.3), the dynamic range of 546 

the image can be modified for optimal stripe visualization. 547 

 548 

5.9.4. Next, click on the Draw Rectangle icon in the top menu of the right window. Select a 549 

stripe that is either horizontal or vertical and draw a rectangle perpendicularly to the stripe. A 550 

profile appears in the central window.  551 

 552 

5.9.5. Click on either Vertical or Horizontal of the Average Projection menu located in the 553 

left panel, depending on whether the stripe orientation is vertical or horizontal.  554 

 555 

5.9.6. Click on Statistics in the central window and read the FWHM value.  556 

 557 



5.9.7. Make a right-click with the computer mouse on the image displayed in the right 558 

window and select Save ROIs.  559 

 560 

NOTE: Open the saved ROIs by clicking on Load ROIs.  561 

 562 

5.9.8. Click on the arrow icon in the top left of the right window, click on the ROI and delete 563 

it by clicking on the bin icon.  564 

 565 

5.9.9. Repeat this operation as many times as needed from different rectangle ROIs until 566 

obtaining the predicted number of AChR stripe widths, which will be representative of the 567 

global value in the analyzed muscle. 568 

 569 

6. Experimental design and statistical tests 570 

 571 

6.1. Perform statistical analyses using specific software.  572 

 573 

NOTE: Data were collected from N ≥ 3 biological replicates and at least 20 NMJs per genotype 574 

for confocal microscope imaging, and N ≥ 5 biological replicates and N = 5 NMJs per genotype 575 

for STED imaging, in each experimental group. Significance was assessed by unpaired Mann-576 

Whitney test (nonparametric), and p-values are indicated in the corresponding figure legends.  577 

 578 

REPRESENTATIVE RESULTS: 579 

In order to facilitate the morphological analysis of neuromuscular junctions at the pre- and 580 

postsynaptic level in a reproducible manner, a workflow was developed from muscle 581 

harvesting to imaging and quantification using the microscope software and ImageJ custom 582 

macros (Figure 1). To exemplify the utility of this protocol, the morphology of NMJs in two 583 

mouse models of genetic disorders, Smn2B/- and ColQDex2/Dex2 mice affected by spinal muscular 584 

atrophy (SMA) and a congenital myasthenic syndrome (CMS) form, respectively, were 585 

evaluated and data were compared to age-matched control littermates.  586 

 587 

The NMJ structure was assessed from tibialis anterior and gastrocnemius muscles of 3- and 6-588 

week-old Smn2B/- (C57Bl/6 background) and ColQDex2/Dex2 (B6D2F1/J background) mice, 589 

respectively, when signs of the disease are already present in these animals. At 3 weeks of 590 

age, Smn2B/- mice show signs of delayed skeletal muscle development and denervation, such 591 

as NMJ atrophy and loss35,36. CMS mice have a primary pathology in NMJs and manifest a 592 

reduction in body weight from the first week of life and marked muscle weakness20 (data not 593 

shown). As shown in Figure 2A, the postsynaptic motor endplate labeled with fluorescent α-594 

bungarotoxin appeared smaller and/or fragmented in mutants of the two mouse lines by 595 

confocal microscopy. Quantification of NMJ Z-stacks using this customized ImageJ macros 596 

revealed marked decreases in endplate volume, maximum intensity projection (MIP), and 597 

relative tortuosity in both SMA and CMS mice compared to controls, as signs of NMJ 598 

maturation defects32 (Figure 2B–D). Postsynaptic endplate volume and MIP were decreased 599 

in diseased animals (fold-change of 2.7 and 2.0 for volume, and 2.5 and 2.0 for MIP, in Smn2B/- 600 

and ColQDex2/Dex2 mice, respectively). The relative tortuosity was also smaller in SMN and ColQ 601 

deficient muscles than WT (16.97% ± 1.33% in SMA versus 48.84% ± 5.90% WT mice, and 602 

13.29% ± 2.79% in CMS versus 30.20% ± 4.44% control mice). In addition, the quantification 603 

of the distribution of presynaptic axon terminal branches using the ImageJ custom macro 604 



revealed an altered pattern in neurofilament M distribution in the two animal models, with 605 

increased immunolabelling (84.65% ± 0.32% versus 16.57% ± 2.03% and 23.64% ± 2.78% 606 

versus 18.77% ± 1.73% in Smn2B/- and  ColQDex2/Dex2 mice compared to controls, respectively) 607 

(Figure 3A–D). By SV2 staining, a 43% reduction in the occupancy ratio, i.e., percent of AChR-608 

containing regions with adjacent nerve terminal active zones, was also observed in Smn2B/- 609 

mice (49.36% ± 3.76% in SMA versus 85.69% ± 2.34% WT mice) (Figure 3E,F). This NMJ 610 

parameter was also calculated in GA of ColQDex2/Dex2 mutants, but no statistically significant 611 

difference was found compared to control littermates (data not shown).  612 

 613 

We further analyzed postsynaptic membrane characteristics by quantifying the distance 614 

between junctional folds and the width of AChR stripes, which are located at the crest of these 615 

folds, in ColQ-deficient muscle using super-resolution stimulated emission depletion (STED) 616 

microscopy. As shown in Figure 4, the aspect of these structures can be clearly visualized by 617 

fluorescent α-bungarotoxin labeling and intensity profile analysis. We, therefore, evaluated 618 

these NMJ parameters and found an increase in the junctional fold distance (d) and width (w) 619 

of AChR stripes in the gastrocnemius muscle of mutants (358.3 nm ± 11.97 nm and 320.8 nm 620 

± 10.90 nm for the distance, and 216.9 nm ± 10.51 nm and 186.3 nm ± 7.015 nm for the width, 621 

in ColQDex2/Dex2 as compared to wild-type mice, respectively, p < 0.05) (Figure 4C,D).  622 

 623 

FIGURE AND TABLE LEGENDS: 624 

Figure 1: Flowchart of the video protocol for 3D multiscale NMJ characterization by confocal 625 

and STED microscopy. Tibialis anterior (TA) and gastrocnemius (GA) muscles were collected 626 

from mice, and muscle fibers were teased before labeling with α-bungarotoxin-F488 or α-627 

bungarotoxin-F633, DAPI, primary antibodies directed against neurofilament M (NF-M) and 628 

synaptic vesicle glycoprotein 2 (SV2), and fluorophore (F488 or F594)-conjugated secondary 629 

antibodies. Image stacks were acquired by confocal microscopy and processed to measure 630 

postsynaptic NMJ volume, presynaptic NF-M accumulation, NMJ axon terminal occupancy, 631 

postsynaptic maximum intensity projection (MIP) endplate area, and tortuosity (dObj(AB) is the 632 

distance between A and B along the perimeter of the object (red line), whereas dEuc(AB) is the 633 

Euclidian distance between A and B (green line)). Image stacks corresponding to at least n = 634 

20 motor endplates for each genotype from N ≥ 3 mice were acquired. For STED microscopy 635 

analysis, the width of acetylcholine receptor (AChR) stripes and the distance between 636 

junctional folds were quantified from intensity profiles of α-BTX-F633 staining.  637 

 638 

Figure 2: Multi-parameter postsynaptic NMJ characterization in mouse models of spinal 639 

muscular atrophy (SMA) and ColQ-related congenital myasthenic syndrome (CMS).  (A) 640 

Representative images of postsynaptic motor endplates from TA and GA muscles labeled with 641 

α-bungarotoxin-F488 (α-BTX). (B) Quantification of NMJ postsynaptic endplate volume, (C) 642 

maximal intensity projection (MIP) area and (D) relative tortuosity in TA of 3 week-old wild-643 

type (WT) and Smn2B/- mice (left graphs, N = 3 animals per genotype, n = 37 and n = 56 NMJs, 644 

respectively) and 6 week-old WT and ColQDex2/Dex2 mice (right graphs, N = 5 mice per genotype, 645 

n = 89 and n = 97 NMJs, respectively). Data are expressed as the mean per mouse (dot) ± SEM. 646 

Differences between groups were analyzed by Mann-Whitney test (* p < 0.05). Scale bar is 10 647 

µm. 648 

 649 

Figure 3: Morphometric analysis of presynaptic axon terminal distribution in muscles of WT 650 

and mutant mice. NMJ innervation pattern in tibialis anterior (TA) and gastrocnemius (GA) 651 



muscles of wild-type, SMA and ColQ-related CMS mice. (A, B) Representative neuromuscular 652 

junctions from TA of WT and Smn2B/- mice at 21 days of age labeled with antibodies against 653 

neurofilament M (NF-M, red) and α-bungarotoxin-F488 (α-BTX, green) (A), and results from 654 

quantitative analysis of neurofilament accumulation (B);  (C, D) Representative neuromuscular 655 

junctions from GA of 6 week-old WT and ColQDex2/Dex2 mice labeled with antibodies against 656 

neurofilament M (NF-M, red) and α-bungarotoxin-F488 (α-BTX, green), showing fragmented 657 

and immature postsynaptic endplates (C), and results of neurofilament accumulation in the 658 

two groups of animals (D). N= 4 (n = 34 NMJs) (B) and N = 3 (n = 54 NMJs) (D) WT animals, and 659 

N=3 (n = 36 NMJs) Smn2B/- and N = 3 (n = 55 NMJs) ColQDex2/Dex2 mice were analyzed in the 660 

experiments (B, D).  (E, F) Representative images of axon terminal occupancy in NMJs from TA 661 

of 3 week-old WT and Smn2B/- mice labeled with antibodies against synaptic vesicle 662 

glycoprotein 2 (SV2, red) and α-bungarotoxin-F488 (α-BTX, green) (E), and results of NMJ 663 

occupancy (SV2/AChR volume ratio) (F). Muscles from N = 3 (n = 50 NMJs) wild-type and N = 664 

4 (n = 62 NMJs) Smn2B/- mice were analyzed.  Data are expressed as the mean value per mouse 665 

(dot) ± SEM. Differences between groups were analyzed by Mann-Whitney test (* p < 0.05). 666 

Scale bars are 20 µm. 667 

 668 

Figure 4: STED imaging of NMJ postsynaptic endplates. (A) Representative STED image of a 669 

NMJ labeled with α-bungarotoxin-F633 (α-BTX) from gastrocnemius of a 6 week-old wild-type 670 

mouse showing postjunctional AChR stripes (scale bar is 5 µm). (B) Higher magnification of a 671 

region with AChR stripes (bottom panel) that was used to generate the intensity profile. The 672 

width (w) of AChR stripes and the distance between two adjacent stripes (d) of this region 673 

were quantified and presented in the bar graph. Schematic representation of the postsynaptic 674 

endplate to illustrate AChR stripe width (w) and distance (d). These parameters, (C) AChR 675 

stripe distance and (D) width, were measured in ColQDex2/Dex2 mice and control littermates at 676 

6 weeks of age. NMJs from 5 WT (total n = 29 NMJs) and 6 ColQDex2/Dex2 (total n = 43 NMJs) 677 

animals were analyzed blindly. Data are expressed as the mean per mouse (dot) ± SEM. 678 

Statistical differences between groups were analyzed by using the Mann-Whitney test (* p < 679 

0.05). 680 

 681 

Supplemental Figure 1: Launch of LAS X software and parameters for confocal acquisitions. 682 

The various steps to acquire confocal images are described in sections 3.1.2 to 3.1.7 of the 683 

protocol. For each NMJ stack acquisition, a project is opened (step 3.1.4) and the parameters 684 

of image size, acquisition speed, X, Y and Z axes are selected (step 3.1.7), with each sequential 685 

scan indicated (Seq.1, laser 405 for DAPI; Seq.2, laser 488 for α-BTX-F488; and Seq.3, laser 552 686 

for F594 conjugated secondary antibodies). 687 

 688 

Supplemental Figure 2: Launch of LAS X software and parameters for STED acquisitions. The 689 

steps to acquire STED images are described in sections 3.2.2 to 3.2.8 of the protocol. The 690 

microscope is launched in configuration mode STED ON (step 3.2.2), and a project is opened 691 

(step 3.2.3). The parameters for image acquisition (step 3.2.7) (image size, acquisition speed, 692 

Zoom factor, X axis), with each sequential scan are indicated (Seq.1 for α-BTX-F633; Seq.2 for 693 

F488 conjugated secondary antibodies). 694 

 695 

Supplemental Figure 3: Images of α-BTX-stained junctional folds obtained by STED 696 

microscopy. Image examples of a postsynaptic endplate labeled with α-BTX-F633 from a 6 697 



week-old wild-type mouse that were acquired with either a correct (left) or incorrect focus 698 

(right). 699 

 700 

Supplemental Figure 4: Windows pop-ups to describe the input and output data obtained 701 

by the custom ImageJ macros. Input data examples (.tif and .lif files) of NMJ images are shown 702 

on the left column. The output data from the macros (right column) are saved in folders 703 

(Save_Volume, Save_Accu) that contain images of the junction (.tif) and datasheets containing 704 

the results (.csv files). 705 

 706 

Supplemental Figure 5: AChR stripe distance and width analysis from a STED acquisition 707 

using the LAS X software. The steps to analyze NMJ STED images are described in section 5 of 708 

the protocol. A) Image of a labeled postsynaptic endplate region containing AChR stripes.  The 709 

region of interest for stripe analysis is selected by drawing a perpendicular line (green line, for 710 

stripe distance), or a perpendicular rectangle (purple rectangle, for stripe width). (B, C) 711 

Intensity profiles of the selected regions and measurements to calculate the distance between 712 

AChR stripes (B) and the AChR stripe width (C) are shown. 713 

 714 

Supplementary Coding File 1: Macro_NMJ_VOL_Marinelloetal. ImageJ custom macro to 715 

extract NMJ parameter measurements (NMJ volume, MIP endplate area, and NMJ tortuosity). 716 

 717 

Supplementary Coding File 2: Macro_NMJ_ACCU_Marinelloetal. ImageJ custom macro to 718 

extract NF-M accumulation and SV2 staining. 719 

 720 

DISCUSSION: 721 

The described video protocol provides a detailed method to quantify the 3D structure of 722 

neuromuscular junctions by combining confocal and STED microscopy that can be used to 723 

characterize pathological changes at the pre- and postsynaptic levels. The high resolution of 724 

STED microscopy allows visualization and morphometric analysis of nanostructures that are 725 

not identifiable by conventional confocal imaging. This procedure enabled us to measure 726 

structural alterations of NMJs in two appendicular muscles, tibialis anterior and 727 

gastrocnemius, of SMA and ColQ-related CMS mice. 728 

 729 

To obtain reliable results with this technique, it is critical to dissect and tease muscles properly, 730 

paying particular attention to the fascia surrounding the muscle and the applied strength to 731 

separate muscle bundles; otherwise, the innervation pattern could be disrupted impeding 732 

proper presynaptic NMJ assessment. Although detailed information is provided to analyze 733 

NMJs from TA and GA, in principle, this protocol could be adapted to other muscles, including 734 

flat muscles, such as the diaphragm or transverse abdominis37, which do not require the 735 

teasing step. Tissue fixation is also crucial to ensure good quality staining; therefore, it is 736 

recommended to use high-quality PFA at an appropriate volume (15–20 times that of the 737 

muscle). In addition, the exposure time to the fixative is an important step because artifacts, 738 

such as shrinkage and clumping, may appear due to over-fixation and influence NMJ features. 739 

Given the size of the samples and the penetration rate of the paraformaldehyde solution in 740 

tissues38, a fixation time of 18–24 h is recommended for this type of muscle. In case the 741 

staining step is planned more than a week after tissue harvesting, it is suggested to keep PFA-742 

fixed muscles in PBS supplemented with sodium azide at 4 °C to prevent bacterial 743 

proliferation. 744 



 745 

This protocol presents an approach using α-BTX-F488 for confocal and α-BTX-F633 for STED 746 

imaging. These fluorophores were chosen to fit with the described experimental design but 747 

can be modified according to the available equipment and materials. For instance, α-BTX F488 748 

labeling can be selected when using a STED CW 592 nm laser for image acquisitions and 749 

quantification.  However, it appears that the configuration that was applied in the present 750 

study (pulsed excitation gated STED, 775 nm depletion) exhibits higher performance and 751 

better resolution than other approaches, such as continuous wave STED39, making it more 752 

suitable for the current application. It is also important to select carefully the laser power 753 

settings, especially for STED (both excitation and depletion), since the characteristics of an 754 

intensity profile cannot be measured in case of saturation, and therefore any saturated signal 755 

in a NMJ image could jeopardize the whole analysis.  756 

 757 

This detailed workflow, including image acquisitions and analysis using microscope software 758 

and ImageJ macros, was developed to facilitate autonomous NMJ morphometric analysis by 759 

confocal and STED microscopy from a single muscle. Previously described workflows for NMJ 760 

confocal analysis, such as NMJ-morph2 or NMJ-Analyser14, paved the way for the design of 761 

semi-automatic methods that facilitate morphological analysis of NMJs and comparative 762 

studies. NMJ-morph (and its updated version aNMJ-morph15) is a free ImageJ-based platform 763 

that uses the maximal intensity projection to measure 21 morphological features, and NMJ-764 

Analyser uses a script developed in Python that generates 29 relevant parameters from the 765 

entire 3D NMJ structure. Manual thresholding is the only step during image processing in 766 

these two methods that require user analysis.  This integrated protocol details steps for tissue 767 

preparation, 3D confocal image acquisitions, and ImageJ-based processing of NMJs from 768 

entire skeletal muscles and provides a simplified overview of five important parameters of the 769 

postsynaptic (volume, maximal projection area, and tortuosity) and presynaptic (axon 770 

terminal occupancy and neurofilament accumulation) endplates. An additional parameter of 771 

biological relevance,  the AChR organization pattern of the postsynaptic junctional folds, was 772 

incorporated for morphometric analysis at the nanoscale level by super-resolution STED 773 

microscopy (resolution 20–30 nm)40. Interestingly, tissue preparation for STED imaging is 774 

simpler than other methods used for NMJ ultrastructural studies, such as conventional 775 

transmission electron microscopy (TEM)9, which is a rather complex and time-consuming 776 

procedure that requires a skilled manipulator in order to obtain ultrathin sections of the 777 

appropriate muscle region. In addition, quantitative data from multiple junctional folds can be 778 

obtained automatically by using the STED-associated software. 779 

 780 

This protocol was applied to illustrate previously known NMJs defects in SMN and ColQ 781 

deficient muscles20,36,41,42. Common changes were found in the two mouse models by confocal 782 

microscopy, such as decreased postsynaptic endplate volume, MIP area, and relative 783 

tortuosity, and increased neurofilament accumulation, whereas some more specific findings 784 

(decreased NMJ occupancy), were observed only in SMA mice, as an indicator of impaired 785 

vesicles trafficking 36. Finally, an increase in AChR stripe distance and width were detected in 786 

ColQ-KO by STED analysis, which are signs of ultrastructural defects in the postsynaptic 787 

junctional folds, as previously observed by TEM20. Importantly, this protocol may help in a 788 

more in-depth morphological characterization of neuromuscular junctions during 789 

development, maintenance, and under various pathological conditions. 790 

 791 
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(Junction1, 2, etc.).

For proprietary format files: create a folder

(Junctions_lif) and save inside single files for

each junction.

For the Volume macro (Macro_NMJ_VOL):

create a folder (Save_Volume) in which the

macro will save single subfolders containing

the data of each analyzed junction.

Each subfolder contains the images of the

junction and the results datasheet. An

additional .csv file is created with a summary of

the results in the root folder (Log_analysis.csv).
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For the Accumulation macro

(Macro_NMJ_ACCU): create a folder

(Save_Accu) in which the macro will save the

detection of the junction, a maximal projection

and datasheets containing the results. An

additional .csv file is created containing a

summary of the results.
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